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IBM InfoSphere Information Server Pack for Oracle
Applications

The IBM® InfoSphere® Information Server Pack for Oracle Applications includes
two stages and one importer to support data integration between InfoSphere
DataStage® and the Oracle E-Business Suite.
v The Direct Access stage provides access to the base tables and database views in

the Oracle E-Business Suite.
v The Hierarchy stage retrieves the multilevel value hierarchy for a specified value

set.
v The Metadata Importer facilitates browsing, selecting, and importing Oracle

Applications metadata into InfoSphere DataStage. This stand-alone importer is
designed to import Oracle Application objects to the InfoSphere DataStage
repository. To load and extract data based on the imported metadata, you must
use the existing database plug-ins such as the Oracle OCI stage or the ODBC
stage. The importer is not designed to work with the Direct Access stage that is
included with this Pack. The Direct Access stage has a separate design time GUI
like the Metadata Importer to browse and select Oracle Application tables.

Installation prerequisites
The release of the platform must be compatible with the requirements of your
release of the IBM InfoSphere Information Server.

For the latest information about software and configuration requirements for the
IBM InfoSphere Information Server Pack for Oracle Applications, see the readme
that is supplied on your installation CD.

Extracting data from Oracle tables with the Direct Access stage
The IBM InfoSphere Information Server Pack for Oracle Applications helps your
company to maximize its existing investments in large ERP systems by
complementing standard software and consulting services for Oracle Applications.

This Pack automatically generates the SQL program that is used to extract data
from Oracle Applications tables. The SQL program accesses the database at design
time to help you build the query. The Direct Access plug-in enables users of all
levels to efficiently build an extraction object and then generate an extraction
program that is written in the SQL language.

Oracle Direct Access plug-in functionality
The Direct Access plug-in offers functionality to extract data directly from Oracle
Applications tables, integrate with data from other sources, and other benefits.

This plug-in is similar to other plug-ins for Enterprise Resource Planning business
management.
v Supports

– Extracting data directly from Oracle Applications tables.
– Integrating with data from other sources by using the visual design process of

IBM InfoSphere DataStage for modeling and deploying source-to-target
transformations.
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v Uses Oracle Call Interface (OCI) at runtime for table access.
v Supports browsing Oracle Applications tables using tools such as generic table

search, by name and description.
v Uses Oracle Applications metadata directly, requiring no additional import of

metadata by using the InfoSphere DataStage and QualityStage® Designer. The
plug-in uses Oracle tables to create metadata at design time. The primary
column data is in the FND_COLUMNS table.

v Lets you construct SQL selection criteria with simple point and click operations.
v Enables delta processing, which captures incremental changes only, on tables or

views selected at design time.
v Supports National Language Support (NLS). For more information, see the

InfoSphere DataStage documentation.

The Direct Access plug-in provides the following functionality:
1. The GUI client component in the InfoSphere DataStage and QualityStage

Designer client logs on to the Oracle Applications database and retrieves
metadata information.

2. The GUI client component reads and writes job properties (for example, the
tables and columns to extract) between the GUI client component and the
InfoSphere DataStage repository.

3. The runtime server component reads job properties from the InfoSphere
DataStage repository.

4. The runtime server component connects to the underlying Oracle Applications
database by using the user-specified connection properties and extracts data
directly from this database.

Installation prerequisites
You install server and client components for the Pack on the IBM InfoSphere
DataStage server and client systems respectively.

In addition to the software requirements for IBM InfoSphere Information Server, a
database account with read access to the following Oracle Applications tables is
required to install and use the Direct Access plug-in for Oracle Applications:
v FND_TABLES

v FND_COLUMNS

v FND_APPLICATION

v FND_APPLICATION_TL

v FND_VIEWS

v FND_VIEW_COLUMNS

For the latest information about software and configuration requirements for the
InfoSphere DataStage Pack for Oracle Applications, review the readme file that is
provided with the Pack.

Overview of building an extraction job
Several tasks are required to build an extraction job with the Oracle Applications
Direct Access stage plug-in to extract data from tables and columns. For example,
you must first create a Data Source Name (DSN) and then create and configure an
IBM InfoSphere DataStage job.
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Procedure
1. Create a Data Source Name (DSN).
2. Create an IBM InfoSphere DataStage job.
3. Define the connection properties that are used by the InfoSphere DataStage and

QualityStage Designer client in the Oracle Applications Direct Access stage.
4. Define the connection properties that are used at runtime.
5. Select the tables and columns to extract.
6. Set the necessary properties for the target stage.
7. Compile the job.

What to do next

See each of the following sections for detailed descriptions of each task.

Creating a Data Source Name
Using standard Microsoft Windows procedures, you create one or more system
Data Source Names (DSNs) on the client that point to the Oracle Applications
databases. These databases contain the metadata tables that describe the tables
from which data is to be extracted.

This DSN, called the design DSN, can be a design time copy of the runtime
database or the actual runtime database.

You must also create a runtime Transparent Network Substrate (TNS) on the
server. Without a runtime TNS, the job does not run because it cannot connect to
the Oracle Applications runtime database.

Creating an extraction job
You create an extraction job by creating an InfoSphere DataStage job that contains
an Oracle Applications Direct Access stage to extract data from Oracle Applications
systems.

Procedure
1. Create a job by using the IBM InfoSphere DataStage and QualityStage Designer

client.
2. Choose Insert > ORAApps from the main menu or select the icon from the

Designer client job palette.
3. Add an output stage and a link.

Defining design time connection properties
You specify connection information for Oracle Applications database instances in
the Properties tab of the ORAApps Stage page.

Right-click the ORAApps icon and select Properties or choose Edit > Properties
from the main menu. The ORAApps Stage dialog contains the following pages:

Stage
Displays the name of the stage that you are editing. The General tab defines
the Oracle Applications data source and log on information to connect to an
Oracle Applications database at design time. For details, see “Connecting to an
Oracle Applications database at design time” on page 4.

Output
Specifies the Oracle Applications data source and log on information to
connect to an Oracle Applications database at runtime. This page specifies the
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associated column definitions and also contains the necessary information for
incremental processing and the SQL SELECT statements used to extract the
data.

Connecting to an Oracle Applications database at design time
About this task

At design time, you set the Oracle Applications connection parameters on the
General tab on the Stage page of the Direct Access plugin GUI.

To connect to an Oracle Applications database:

Procedure
1. Enter the Data Source Name (DSN) that you created for the design time

database in the Oracle Apps DSN field. The output link uses this DSN to
connect to the Oracle Applications database so that the plugin can use the
Oracle Applications metadata at design time to add tables and columns to the
link. This field is required. There is no default, and only one output link can
exist.

2. Enter the name to use to connect to the Oracle Applications database in User
ID. The user must be a valid user in the database, have an alias in the
database, or be a system administrator or system security officer. This user
must have sufficient privileges to access the specified database and source
table. This field is required. There is no default.

3. Enter the password that is associated with the specified user name to use in
Password. This field is required. There is no default.

4. Enter the table owner that is associated with the tables in the Oracle
Applications database in Table Owner. This field is required. There is no
default.

5. Enter an optional description of the Direct Access plug-in stage in Description.

Results

See your system administrator for assistance with the user ID, password, and table
owner.

Defining the connection properties used at runtime
For your job to run successfully at runtime, you must define the connection to the
runtime Oracle Applications database.

ORAApps Stage Output General stage
You use the Output page to identify the TSN for the database that contains the
tables to be queried at runtime.

The Output page has the following options:

Output name
Contains the name of the output link. Choose the link that you want to edit
from the Output name list, which displays the output link from the Direct
Access plugin stage.

Columns
Displays a list of the columns designated on the output link.
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General tab
You use the Stage General page to define the basic connection parameters for your
extraction job.

Runtime TNS Name.
Contains the name of the server Transparent Network Substrate (TNS) that you
created for the runtime database. This TNS identifies which tables and columns
to query at runtime and is required. If this information is incorrect or missing,
the Direct Access plug-in cannot connect to the Oracle Applications runtime
database. There is no default value.

User Name.
Contains the name to use to connect to the Oracle Applications database. Enter
a name that identifies a valid user in the database, has an alias in the database,
or is a system administrator or system security officer. This user must have
sufficient privileges to access the specified database and source table. This field
is required and there is no default value.

Password.
Contains the password that is associated with the specified user name. This
field is required and there is no default value.

Table names.
Contains a list of the tables to be queried at runtime. This field is protected
and can be updated only by using the Browse button.

Browse.
Provides access to the Tables that you selected for the query dialog to add
tables and columns to the stage.

Table Owner.
Identifies the table owner that is associated with the tables in the Oracle
Applications database. The owner is used to create a complete ANSI table
name. This field is required and there is no default value.

Save User-Defined SQL.
Enables you to modify the SQL on the User-defined tab on the Output SQL
page.

Description.
Contains an optional description of the link.

Selecting the tables and columns to extract
You use the Tables selected for query dialog to identify the Oracle Applications
tables and columns to be extracted at runtime.

Tables selected for query dialog:

You use the Tables selected for query dialog to define new tables or views for the
query. When no tables are present in the table list, the window opens as blank.

This dialog contains the following parameters:

Item.
Contains the selected table name and column names.

Description.
Contains the Oracle Applications description of the selected table and columns.

Add Table.
Opens the Available tables for query dialog to select a table and columns to
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query. After selecting the first table, you can add another table with a
relationship to the first table. Click Add Table again after the first selected
table is listed in the Tables selected for query dialog.

Add View.
Displays all available views by application area. See “Adding views” on page 7
for more information.

Modify.
Enables you to modify the highlighted column or table. If previous tables or
views are selected, Modify is enabled.

Delete.
Removes the highlighted column or table. If previous tables or views are
selected, Delete is enabled.

OK.
When all the tables and columns for the query are selected, click to return to
the Output page of the ORAApps Stage dialog. Clicking OK saves the tables
and column metadata on the Columns tab.

Cancel.
Leaves the tables and columns unchanged.

Available tables for query dialog:

You use Available tables for query dialog to select a table to query. This dialog
contains a list of tables and applications in the Oracle Applications database with
their descriptions. In the dialog, click on the plus (+) sign to show all tables in the
application area.

Click Add Table on the Tables selected for query dialog to open the Available
tables for query dialog.

Find in List
Specifies any criteria for limiting the number of tables that are shown in the
list. This field is case sensitive and searches the table name and the description.
Only the tables found as a result of the search display in the Name and
Description list.

Name and Description
You can expand the tree under a given application area to see all the tables in
the application area that are available for query. The full list of tables for which
the table owner has authority is shown by default. The list includes the
associated Oracle Applications description for each table. Highlight the table to
be queried.

Find
Performs a case-insensitive search based on the criteria set in Find in List for
the application area and the tables. If an application area meets the find
criteria, it shows all tables in that application area. If a table name meets the
find criteria, it shows the application area, but only the tables in the
application area that meet the find criteria are shown.

OK Selects the highlighted table that you selected. When you click OK, the
Columns for selected table dialog opens.

Cancel
Returns to the Tables selected for query dialog.
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Columns for selected table dialog:

You use the Columns for selected table dialog to select the columns to be requested
in the query. The list of columns is based on the table that is selected in the
Available tables for query dialog.

When you click OK on the Available tables for query dialog, the Columns for
selected table dialog opens.

Column Name.
Contains a list of all available columns for the selected table on the left side of
the dialog.

Description.
Contains a list of corresponding descriptions of each column as contained in
the Oracle Applications table.

Column Name.
Contains a list of all selected columns that are selected for the query on the
right side of the dialog.

Description.
Contains a list of corresponding descriptions of each column.

OK Returns to the Tables selected for query dialog. At least one column must be
selected before you click OK.

Cancel
Returns to the Available tables for query dialog without adding the table.

Adding views:

You use the Tables selected for query dialog to add views for the query.

Procedure

1. Click Add View on the Tables selected for query dialog to open the Available
business views for query dialog. This dialog shows all available views by
application area from which you can select.

2. Select the table that you want and click OK.
The Columns for selected table dialog opens, displaying all the columns in the
view.

3. Click OK to reopen the Business view selected for query dialog with the view
and columns added to the extraction tree. You cannot remove an individual
column, only the actual view.

Results

IBM InfoSphere DataStage runs the generated SQL statement for the selected view
as is, or by adding Delta or Selection tab information to the base query on the
SQL tab of the Output page.

The General tab of the Output page then shows the updated table name list.

The following example indicates that an alias, T1, is assigned for the updated table:
FND_SEGMENT_ATTRIBUTE_VALUES T1

This allows use of the same table again in the query.
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Columns tab:

The Columns tab on the Output page shows the detail metadata definition of the
data to be extracted from one or more Oracle Applications tables. All descriptions
are maintained on this tab.

The metadata is created and displayed after selecting tables and columns from the
Tables selected for query dialog. Do not delete or change any columns. If you need
to change a column, change the criteria in the General tab.

Column name.
Contains the table alias and column name, separated by a period.

Derivation.
Contains the name that is used when building the actual query.

Description.
Contains the actual column description from the Oracle Applications metadata.

Save
Saves the metadata to the IBM InfoSphere DataStage repository.

Load
Copies the column definitions from the InfoSphere DataStage repository.

Join tab:

The Join tab is located on the Output page. Enable the Use this Join in SQL
statement to join the primary and foreign keys that are found in both tables.

Capturing incremental changes
Capturing incremental changes, known as data capture, increases the efficiency of
data extractions. You use the Delta tab on the Output page to implement change
data capture on the server.

Available delta tables.
Lists the names and descriptions of each table on the server from which data is
extracted at runtime, such as FND_SEGMENT. The tables must be specified in the
Table names field on the Output General page.

To enable delta processing, you select a table listed in Available delta tables
and move it to Selected Delta tables.

Path to delta file.
Specifies a unique path for the file on the server that stores the date and time
of each successful run. The path is required to enable delta processing.

You can select a file to contain the information by using the Browse button.

Selected Delta tables.
Use the arrow key (>) to move the table from Available delta tables to Selected
Delta tables for delta processing.

Example of delta processing:

The plug-in updates the text file on the IBM InfoSphere DataStage server when the
stage completes successfully. The delta file path is required to enable delta
processing.

The most recent entries are at the beginning. If the results of the most recent run
are unsatisfactory, remove the most recent entry in the delta file and rerun the job.
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The date time stamp is used on subsequent runs, that is, for each job run after the
initial run, rows are extracted from the selected Oracle Applications tables. This
process is completed according to the specified selection criteria only if the row in
the table or tables specified in Selected Delta tables has been added or modified
since the last run.

The last column in the list shows a timestamp in seconds since 12:00 a.m. The
actual time is converted to seconds and compared to this value to validate that the
file is unchanged. Only the last eleven runs are kept in this file, with older entries
removed on each new run of the job. Delta processing is based on the tables or
view selected at design time.

The following example shows the appended text for the executed query when
delta processing is enabled. See the Generated tab of the SQL page for more
information.
AND (T1.LAST_UPDATE_DATE > [lastDateTime] AND T1.LAST_UPDATE_DATE <=
[currentDateTime])

lastDateTime
This value comes from the delta file that is defined on the Delta tab. If the
delta file does not exist, the default value of 1970-01-01 00:00:00 is used as
the starting point.

currentDateTime
This value is replaced with the system date and time when the InfoSphere
DataStage job begins. This value is then written to the delta file only when the
job completes successfully and used as the lastDateTime on the next run.

Selecting the data to be extracted
You use the Selection tab on the Output page to specify the criteria by which data
is selected for the query.

The tab contains the following parameters, similar to the other IBM InfoSphere
DataStage plug-ins:

WHERE clause.
Contains the SQL WHERE clause to select certain rows from the source tables.

Other clauses.
Specifies any additional clauses to be included in the generated SQL statement.

SQL tab
The SQL tab has the Generated and User-defined tabs, which are similar to those
for the other IBM InfoSphere DataStage plug-ins.

The SQL Generated tab shows the current query that was generated by InfoSphere
DataStage. This tab displays the generated SQL that is run on the server at
runtime.

The SQL shows the FROM clause including any join information, if appropriate,
based on table selection. The concatenated WHERE clause contains the information
from the Selection tab to filter rows from the base query (not the database view).

The SQL also displays delta information that is concatenated to the base query if
delta processing is enabled for any tables in the query.
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The User-defined tab is only accessible when Save User-Defined SQL is selected
on the General tab on the Output page. This tab lets you enter any valid SQL
statement.

Completing the job
Complete the definition of the other stages in your job design according to the
normal IBM InfoSphere DataStage procedures, then compile and run the job.

Validating runtime jobs
Because of the complexity of the stage properties, you should check that they work
when you run the job. Use the validation service provided by the IBM InfoSphere
DataStage and QualityStage Director client.

Extracting Oracle hierarchical data with the Hierarchy Access stage
The Oracle Applications Hierarchy Access plug-in lets you extract hierarchies from
an Oracle Applications system database. You can load these hierarchies into a
business warehouse such as SAP. This stage is a passive stage that has output links
but no input links.

The data in an Oracle Applications hierarchy is difficult to parse, requiring
complex SQL to create a complete hierarchy structure. This plug-in reads this
complex data set, flattens the view, and provides the details for a business
warehouse. Standard SQL from IBM InfoSphere DataStage cannot do this.

This plug-in includes NLS (National Language Support).

Oracle Applications Hierarchy Access plug-in functionality
The Oracle Applications Hierarchy Access plug-in offers functionality to extract
data directly from Oracle Applications tables, integrate with data from other
sources, and other benefits.
v Supports

– Extracting data directly from Oracle Applications tables.
– Integrating data with data from other sources, using the visual design process

of IBM InfoSphere DataStage for modeling and deploying source-to-target
transformations.

– Loading data into a target data store.
v Extracts a given value set ID and parent ID combination.
v Uses ODBC at runtime to access the application data.
v Provides only valid entries in the tree. Ranges have only valid values returned,

and duplicate entries point to the same parent.
v Metadata displays automatically on the Columns tab. All columns are always

supplied. For example, node, parent node, value, start date, end date, and
description.

v Nodes are unique to the value set and parent ID selection.

Installation prerequisites
You install server and client components for the Pack on the IBM InfoSphere
DataStage server and client systems respectively.

In addition to the software requirements for the Oracle Applications Hierarchy
Access plug-in that are described in the readme, you must have a database account
with read access to the following Oracle Applications tables:
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v FND_TABLES

v FND_COLUMNS

v FND_APPLICATION

v FND_APPLICATION_TL

v FND_VIEWS

v FND_VIEW_COLUMNS

Overview of building an extraction job
Several tasks are required to build an extraction job with the Oracle Applications
Hierarchy Access plug-in to extract data from tables and columns. For example,
you must first create a Data Source Name (DSN) and then create and configure an
IBM InfoSphere DataStage job.

Procedure
1. Create a Data Source Name (DSN).
2. Create an IBM InfoSphere DataStage job.
3. Define the connection properties that are used at runtime on the General tab of

the Stage page.
4. Define the properties that are used at design time in the Oracle Applications

Hierarchy Access stage on the Output page.
5. Define the properties for the target stage by using the standard InfoSphere

DataStage procedures.
6. Compile and run the job.

What to do next

See each of the following sections for detailed descriptions of each task.

Creating a Data Source Name
Using standard Microsoft Windows procedures, you create one or more system
Data Source Names (DSNs) on the client that point to the Oracle Applications
databases. These databases contain the metadata tables that describe the tables
from which data is to be extracted.

You must also create a runtime ODBC DSN on the server. Without a runtime DSN,
the job does not run because it cannot connect to the Oracle Applications runtime
database.

Creating an extraction job
You create an extraction job by creating an InfoSphere DataStage job that contains
an Oracle Applications Hierarchy Access stage to extract data from Oracle
Applications systems.

About this task

Oracle Applications hierarchy data is difficult to parse because it requires complex
SQL to create a complete hierarchy structure. The following output from the
plug-in shows how the data appears after running the Hierarchy Access extraction
program:
v The original parent record appears at the top (Parent ID = PT).
v The numbers on the left represent the node value assigned.
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v The value after the node ID is the value identified within the Oracle hierarchy
table.

v The number following the node value is the parent node ID. This indicates that
all node values that have a parent of 7 can be identified as Accounts Receivable
Total.

Procedure
1. Create a job by using the IBM InfoSphere DataStage and QualityStage

Designerclient.
2. Add the Oracle Applications Hierarchy Access stage by using the Designer

client tool palette.
3. Add an output stage and add a link. (The Hierarchy Access stage should

always be the first stage for a link because it is a data source provider.)

Summary:

The Oracle Applications Hierarchy Access stage extracts the Value Set ID and
Parent ID combination. As the stage runs, it extracts data from within the range of
values for the specified node. Only the values that exist within the range are
added to the output.

After entering information on the General tab, the Columns tab is automatically
updated, based on the fixed field names.

Since all columns must be extracted, you can use a subsequent Transformer stage
to eliminate unwanted columns. Use one for each run of the plug-in with new
values, which start with 1, being assigned. (This requires reloading your validation
and lookup table on the data warehouse, rather than adding new entries.)

Defining runtime connection properties
Double-click the Hierarchy Access stage to edit it. The Hierarchy Access Stage
dialog opens.

This dialog can have the following field and pages, depending on whether you
install National Language Support (NLS) :
v Stage name. Displays the name of the stage you are editing.
v Stage. The General tab defines the Hierarchy Access data source and logon

information to connect to an Oracle Applications system database at runtime.
v NLS. This page defines a character set map to use with the stage, if required. It

has the NLS page only if you installed NLS.
v Output. Specifies the Oracle Applications hierarchy to select at design time. This

page also specifies the associated column definitions.

Hierarchy Access Stage General page
Use the General tab of the Stage page of the Hierarchy Access plug-in GUI to
identify the Oracle Applications data source and logon information. It lets you
connect to an Oracle Applications system (an Oracle Applications system database)
at runtime to run the job.

The General tab has the following fields. They are all required except Description.
v Data source name. Contains the name of the data source that you created for the

runtime ODBC connection to the Oracle Applications system database.
v User name. Contains a valid user name for the specified data source to connect

to the Oracle Applications system database.
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v Password. Contains a valid password that is associated with the User ID to
connect to the Oracle Applications system database.

v Table Owner. Identifies the table owner that is associated with the tables in the
Oracle Applications system database.

v Description. Optionally describes the Hierarchy Access stage.

Defining character set maps
You can optionally define a character set map for a Hierarchy Access stage by
using the NLS tab.

You can change the default character set map that is defined for the project or the
job by selecting a map name from the list. This tab also has the following
components:
v Show all maps. Lists all the maps supplied with IBM InfoSphere DataStage.

Maps cannot be used unless they have been loaded by using the IBM InfoSphere
DataStage and QualityStage Administrator client.

v Loaded maps only. Displays the maps that are loaded and ready to use.
v Use Job Parameter. Specifies a character set map as a parameter to the job

containing the stage. If the parameter has not yet been defined, you are
prompted to define it from the Job Properties dialog in the InfoSphere DataStage
and QualityStage Designer client.

Defining extraction criteria
Use the Output page to select an Oracle Applications hierarchy at design time. The
Output page has the following field and tabs:
v Output name. Displays the name of the output link. Choose the link you want

to edit from the list.
v General tab. Specifies the value set and node to extract.
v Columns button. Click for a list of the associated column definitions for the

fields to be extracted regardless of which hierarchy you selected.
v Columns tab. Shows the metadata for the data to be extracted from the selected

hierarchy.

Output General page
The General tab of the Output page opens by default.

The General tab has the following:
v Value Set ID. Specifies the child elements within the parent node for extraction.

This is a required field.
v Parent ID. Specifies the parent node for extraction. This is a required field.
v Work File. Identifies the name and location of the work files created for this

hierarchy. This is a required field. You can also browse for the .txt file.
For each level in the hierarchy, a new .txt file is created and removed during a
normal job run. When you validate the job, you can review the work files that
remain. A maximum of 15 levels are processed.

v Description. Contains an optional description of the link.

Output Columns page
After selecting a view or tables with columns on the General tab, the Columns tab
is automatically updated, based on the fixed field names. It shows the column
definitions with the detail metadata for the hierarchy to be extracted from the
Oracle Applications database. They are required for the server.
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Since all columns must be extracted, you can use a subsequent Transformer stage
to eliminate unwanted columns. Use one for each run of the plug-in, with new
values being assigned, starting with 1. (This requires reloading your validation and
lookup table on the data warehouse, rather than adding new entries.)

The Columns tab has the following components (the same fields appear regardless
of which hierarchy you select) :
v NodeID. The internal ID of the hierarchy node.
v NodeValue. The value label of the hierarchy node.
v ParentNode. The internal ID of the parent node.
v StartActive. The start date defined within Oracle Applications.
v EndActive. The end date defined within Oracle Applications.
v Description. The description of the hierarchy.
v Language. The language specified for the text.
v Summary. The flag defined in Oracle Applications for parent/child summary

information that is based on the view.
v Click Save to save the definitions to the IBM InfoSphere DataStage repository.
v Click Load to copy the definitions from the InfoSphere DataStage repository.

Completing the job
About this task

Complete the definition of the other stages in your job design according to the
normal IBM InfoSphere DataStage procedures. Compile the job by using the
InfoSphere DataStage and QualityStage Designerclient, and run it by using the
InfoSphere DataStage and QualityStage Director client.

Importing Oracle metadata into DataStage with the Metadata
Importer

IBM InfoSphere Information Server Pack for Oracle Applications includes a
standalone Metadata Importer. The importer facilitates browsing, selecting, and
importing Oracle Applications metadata into the InfoSphere DataStage.

This standalone importer is designed to import Oracle Application objects to the
InfoSphere DataStage repository. To load and extract data based on the imported
metadata, you need to use the existing database plug-ins such as Oracle OCI stage
or ODBC stage. The importer is not designed to work with the Direct Access stage
included with this Pack. The Direct Access stage has a separate design time GUI,
similar to the Metadata Importer, to browse and select Oracle Application tables.

Installation prerequisites Metadata Importer
The following prerequisites are required to run the Metadata Importer successfully:
v A full installation of IBM InfoSphere DataStage is required, refer to the readme

for additional details.
v You will need a Database account with at least read only access to the Oracle

Application Object Library tables and certain system tables. The Oracle
Application Object Library tables include but are not limited to: FND_TABLES,
FND_COLUMNS, FND_APPLICATION, FND_APPLICATION_TL, FND_VIEWS,
FND_VIEW_COLUMNS. The system tables include USER_TAB_COLUMNS,
USER_COL_COLUMNS and others.
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v Install the Microsoft Date Access Components (MDAC) version 2.7 or later.
Install the InfoSphere DataStage re-branded ODBC drivers. Use the Oracle Wire
Protocol to configure an ODBC DSN for accessing the Oracle E-business Suite
database.

Browse Interface tables
The Interface tables provide temporary places to hold imported data from external
data sources.

About this task

To import the definitions of the Oracle Applications interface tables into IBM
InfoSphere DataStage, follow the steps below.

Procedure
1. Select from the Tools menu, Browse Interface tables. The Browse Interface

Tables window opens. A list of Oracle Applications appear.
2. Expand the appropriate application and check the box of the interface table(s)

you want to import. To search for a table, enter the filter criteria in the Filter
Field and Filter List, and click Search.

3. Select from the Tools menu, Import Selected tables. If importing a single table
go to step 4. If importing more than one table the Select Import Options
window opens. Select either to Import each selected InfoSphere DataStage
table as one table or to Merge the selected DataStage tables into one by
clicking in the appropriate check box. If importing tables, enter or select the
InfoSphere DataStage category and click Continue. If merging tables. go to step
4.

4. Enter the InfoSphere DataStage table definition name or click the browse
button next to the name field and choose from the InfoSphere DataStage
options. Click the Import tables button.

5. Click Exit when complete.

Browse Base tables
The Base tables are tables registered within the Oracle E-business Suite.

About this task

To import the definitions of the Oracle Applications base tables into IBM
InfoSphere DataStage, follow the steps below.

Procedure
1. Select from the Tools menu, Browse Base tables. The Browse Base tables

window opens.
2. A list of Oracle Applications appear. Expand the appropriate application and

check the box of the base table(s) you want to import. To search for a table,
enter the filter criteria in the Filter Field and Filter List, and click Search.

3. Select from the Tools menu, Import Selected tables. If importing a single table
go to step 4. If importing more than one table the Select Import Options
window opens. Select either to Import each selected InfoSphere DataStage
table as one table or to Merge the selected DataStage tables into one by
clicking in the appropriate check box. If importing tables, enter or select the
InfoSphere DataStage category and click Continue. If merging tables, go to step
4.
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4. Enter the InfoSphere DataStage table definition name or click the browse
button next to the name field and choose from the InfoSphere DataStage
options.

5. Click the Import tables button.
6. Click Exit when complete.

Browse Views
Oracle E-Business Suite database views are database objects that contain the result
set of an SQL query. The database views provide a read-only view of the Oracle
Applications data.

About this task

For example, the view “GLBV_GL_SET_OF_BOOKS” lists the sets of books defined
as a financial reporting entity that includes a chart of accounts, accounting
calendar and functional currency. To browse and import the definitions of the
Oracle Applications views into IBM InfoSphere DataStage, follow the steps below.

Procedure
1. Select from the Tools menu, Browse Views. The Browse Views window opens.
2. A list of Oracle Applications appears. Expand the appropriate application and

check the box of the view(s) you want to import. To search for a view, enter the
filter criteria in the Filter Field and Filter List, and click Search.

3. Select from the Tools menu, Browse views. If importing a single view go to
step 4. If importing more than one view the Select Import Options window
appears. Select either to Import each selected InfoSphere DataStage table as
one table or to Merge the selected InfoSphere DataStage tables into one by
clicking in the appropriate check box. If importing views, enter or select the
InfoSphere DataStage category and click Continue. If merging views. go to step
4.

4. Enter the InfoSphere DataStage table definition name or click the browse
button next to the name field and choose from the InfoSphere DataStage
options.

5. Click the Import tables button.
6. Click Exit when complete.

Browse Selected Tables/Views
About this task

From the Tools menu, select Browse Selected Tables/Views to display a list of the
current tables or views that are selected. From this view, you can deselect a table
or view by clicking in the check box.

Import Selected Tables/Views
About this task

To import all the selected tables or views:

Procedure
1. Choose from the Tools menu, Import Selected Tables/Views. The Select Import

Options window opens.
2. Select either to Import each selected InfoSphere DataStage table as one table

or to Merge the selected InfoSphere DataStage tables into one by clicking in
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the appropriate check box. Enter or select the InfoSphere DataStage category or
table definition name for the selected tables. Click Continue and go to step 5.

3. In the Import Selected Tables window, enter the InfoSphere DataStage table
definition name or click the Browse button next to the name field and choose
from the InfoSphere DataStage options.

4. Click the Import tables button.
5. Click Exit when complete.
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Appendix A. Product accessibility

You can get information about the accessibility status of IBM products.

The IBM InfoSphere Information Server product modules and user interfaces are
not fully accessible.

For information about the accessibility status of IBM products, see the IBM product
accessibility information at http://www.ibm.com/able/product_accessibility/
index.html.

Accessible documentation

Accessible documentation for products is provided in IBM Knowledge Center. IBM
Knowledge Center presents the documentation in XHTML 1.0 format, which is
viewable in most web browsers. Because IBM Knowledge Center uses XHTML,
you can set display preferences in your browser. This also allows you to use screen
readers and other assistive technologies to access the documentation.

The documentation that is in IBM Knowledge Center is also provided in PDF files,
which are not fully accessible.

IBM and accessibility

See the IBM Human Ability and Accessibility Center for more information about
the commitment that IBM has to accessibility.
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Appendix B. Contacting IBM

You can contact IBM for customer support, software services, product information,
and general information. You also can provide feedback to IBM about products
and documentation.

The following table lists resources for customer support, software services, training,
and product and solutions information.

Table 1. IBM resources

Resource Description and location

IBM Support Portal You can customize support information by
choosing the products and the topics that
interest you at www.ibm.com/support/
entry/portal/Software/
Information_Management/
InfoSphere_Information_Server

Software services You can find information about software, IT,
and business consulting services, on the
solutions site at www.ibm.com/
businesssolutions/

My IBM You can manage links to IBM Web sites and
information that meet your specific technical
support needs by creating an account on the
My IBM site at www.ibm.com/account/

Training and certification You can learn about technical training and
education services designed for individuals,
companies, and public organizations to
acquire, maintain, and optimize their IT
skills at http://www.ibm.com/training

IBM representatives You can contact an IBM representative to
learn about solutions at
www.ibm.com/connect/ibm/us/en/
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Appendix C. Accessing the product documentation

Documentation is provided in a variety of formats: in the online IBM Knowledge
Center, in an optional locally installed information center, and as PDF books. You
can access the online or locally installed help directly from the product client
interfaces.

IBM Knowledge Center is the best place to find the most up-to-date information
for InfoSphere Information Server. IBM Knowledge Center contains help for most
of the product interfaces, as well as complete documentation for all the product
modules in the suite. You can open IBM Knowledge Center from the installed
product or from a web browser.

Accessing IBM Knowledge Center

There are various ways to access the online documentation:
v Click the Help link in the upper right of the client interface.
v Press the F1 key. The F1 key typically opens the topic that describes the current

context of the client interface.

Note: The F1 key does not work in web clients.
v Type the address in a web browser, for example, when you are not logged in to

the product.
Enter the following address to access all versions of InfoSphere Information
Server documentation:
http://www.ibm.com/support/knowledgecenter/SSZJPZ/

If you want to access a particular topic, specify the version number with the
product identifier, the documentation plug-in name, and the topic path in the
URL. For example, the URL for the 11.3 version of this topic is as follows. (The
⇒ symbol indicates a line continuation):
http://www.ibm.com/support/knowledgecenter/SSZJPZ_11.3.0/⇒
com.ibm.swg.im.iis.common.doc/common/accessingiidoc.html

Tip:

The knowledge center has a short URL as well:
http://ibm.biz/knowctr

To specify a short URL to a specific product page, version, or topic, use a hash
character (#) between the short URL and the product identifier. For example, the
short URL to all the InfoSphere Information Server documentation is the
following URL:
http://ibm.biz/knowctr#SSZJPZ/

And, the short URL to the topic above to create a slightly shorter URL is the
following URL (The ⇒ symbol indicates a line continuation):
http://ibm.biz/knowctr#SSZJPZ_11.3.0/com.ibm.swg.im.iis.common.doc/⇒
common/accessingiidoc.html
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Setting up a locally installed information center

IBM Knowledge Center contains the most up-to-date version of the documentation.
However, you can install a local version of the documentation as an information
center and configure your help links to point to it. A local information center is
useful if your enterprise does not provide access to the internet.

Set up a locally installed information center on the computer of your choice by
completing one of the following actions:
v Use the installation instructions that come with the information center

installation package
v Use the installation instructions in the following technote: http://www-

01.ibm.com/support/docview.wss?uid=swg27042237

Changing help links to refer to locally installed documentation

After you install and start your locally installed information center, you can use the
iisAdmin command on the services tier computer to change the documentation
location that the product help links refer to. (The ⇒ symbol indicates a line
continuation):

Windows
IS_install_path\ASBServer\bin\iisAdmin.bat -set -key ⇒
com.ibm.iis.infocenter.url -value http://<host>:<port>/help/topic/

AIX® Linux
IS_install_path/ASBServer/bin/iisAdmin.sh -set -key ⇒
com.ibm.iis.infocenter.url -value http://<host>:<port>/help/topic/

Where <host> is the name of the computer where the information center is
installed and <port> is the port number for the information center. The default port
number is 8888. For example, on a computer named server1.example.com that uses
the default port, the URL value would be http://server1.example.com:8888/help/
topic/.

Obtaining PDF documentation

The PDF file books are available online and can be accessed from this support
document: https://www.ibm.com/support/docview.wss?uid=swg27008803&wv=1.
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Appendix D. Providing feedback on the product
documentation

You can provide helpful feedback regarding IBM documentation.

Your feedback helps IBM to provide quality information. You can use any of the
following methods to provide comments:
v To provide a comment about a topic in IBM Knowledge Center that is hosted on

the IBM website, sign in and add a comment by clicking Add Comment button
at the bottom of the topic. Comments submitted this way are viewable by the
public.

v To send a comment about the topic in IBM Knowledge Center to IBM that is not
viewable by anyone else, sign in and click the Feedback link at the bottom of
IBM Knowledge Center.

v Send your comments by using the online readers' comment form at
www.ibm.com/software/awdtools/rcf/.

v Send your comments by e-mail to comments@us.ibm.com. Include the name of
the product, the version number of the product, and the name and part number
of the information (if applicable). If you are commenting on specific text, include
the location of the text (for example, a title, a table number, or a page number).
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Notices and trademarks

This information was developed for products and services offered in the U.S.A.
This material may be available from IBM in other languages. However, you may be
required to own a copy of the product or product version in that language in order
to access it.

Notices

IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user's responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785 U.S.A.

For license inquiries regarding double-byte character set (DBCS) information,
contact the IBM Intellectual Property Department in your country or send
inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.
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Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
J46A/G4
555 Bailey Avenue
San Jose, CA 95141-1003 U.S.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurements may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or
withdrawal without notice, and represent goals and objectives only.

This information is for planning purposes only. The information herein is subject to
change before the products described become available.

This information contains examples of data and reports used in daily business
operations. To illustrate them as completely as possible, the examples include the
names of individuals, companies, brands, and products. All of these names are
fictitious and any similarity to the names and addresses used by an actual business
enterprise is entirely coincidental.

COPYRIGHT LICENSE:
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This information contains sample application programs in source language, which
illustrate programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. The sample
programs are provided "AS IS", without warranty of any kind. IBM shall not be
liable for any damages arising out of your use of the sample programs.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

© (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. © Copyright IBM Corp. _enter the year or years_. All rights
reserved.

If you are viewing this information softcopy, the photographs and color
illustrations may not appear.

Privacy policy considerations

IBM Software products, including software as a service solutions, (“Software
Offerings”) may use cookies or other technologies to collect product usage
information, to help improve the end user experience, to tailor interactions with
the end user or for other purposes. In many cases no personally identifiable
information is collected by the Software Offerings. Some of our Software Offerings
can help enable you to collect personally identifiable information. If this Software
Offering uses cookies to collect personally identifiable information, specific
information about this offering’s use of cookies is set forth below.

Depending upon the configurations deployed, this Software Offering may use
session or persistent cookies. If a product or component is not listed, that product
or component does not use cookies.

Table 2. Use of cookies by InfoSphere Information Server products and components

Product module
Component or
feature

Type of cookie
that is used Collect this data Purpose of data

Disabling the
cookies

Any (part of
InfoSphere
Information
Server
installation)

InfoSphere
Information
Server web
console

v Session

v Persistent

User name v Session
management

v Authentication

Cannot be
disabled

Any (part of
InfoSphere
Information
Server
installation)

InfoSphere
Metadata Asset
Manager

v Session

v Persistent

No personally
identifiable
information

v Session
management

v Authentication

v Enhanced user
usability

v Single sign-on
configuration

Cannot be
disabled
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Table 2. Use of cookies by InfoSphere Information Server products and components (continued)

Product module
Component or
feature

Type of cookie
that is used Collect this data Purpose of data

Disabling the
cookies

InfoSphere
DataStage

Big Data File
stage

v Session

v Persistent

v User name

v Digital
signature

v Session ID

v Session
management

v Authentication

v Single sign-on
configuration

Cannot be
disabled

InfoSphere
DataStage

XML stage Session Internal
identifiers

v Session
management

v Authentication

Cannot be
disabled

InfoSphere
DataStage

IBM InfoSphere
DataStage and
QualityStage
Operations
Console

Session No personally
identifiable
information

v Session
management

v Authentication

Cannot be
disabled

InfoSphere Data
Click

InfoSphere
Information
Server web
console

v Session

v Persistent

User name v Session
management

v Authentication

Cannot be
disabled

InfoSphere Data
Quality Console

Session No personally
identifiable
information

v Session
management

v Authentication

v Single sign-on
configuration

Cannot be
disabled

InfoSphere
QualityStage
Standardization
Rules Designer

InfoSphere
Information
Server web
console

v Session

v Persistent

User name v Session
management

v Authentication

Cannot be
disabled

InfoSphere
Information
Governance
Catalog

v Session

v Persistent

v User name

v Internal
identifiers

v State of the tree

v Session
management

v Authentication

v Single sign-on
configuration

Cannot be
disabled

InfoSphere
Information
Analyzer

Data Rules stage
in the InfoSphere
DataStage and
QualityStage
Designer client

Session Session ID Session
management

Cannot be
disabled

If the configurations deployed for this Software Offering provide you as customer
the ability to collect personally identifiable information from end users via cookies
and other technologies, you should seek your own legal advice about any laws
applicable to such data collection, including any requirements for notice and
consent.

For more information about the use of various technologies, including cookies, for
these purposes, see IBM’s Privacy Policy at http://www.ibm.com/privacy and
IBM’s Online Privacy Statement at http://www.ibm.com/privacy/details the
section entitled “Cookies, Web Beacons and Other Technologies” and the “IBM
Software Products and Software-as-a-Service Privacy Statement” at
http://www.ibm.com/software/info/product-privacy.
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Terms and conditions for product documentation

Permissions for the use of these publications are granted subject to the following
terms and conditions.

Applicability
These terms and conditions are in addition to any terms of use for the IBM
website.

Personal use
You may reproduce these publications for your personal, noncommercial
use provided that all proprietary notices are preserved. You may not
distribute, display or make derivative work of these publications, or any
portion thereof, without the express consent of IBM.

Commercial use
You may reproduce, distribute and display these publications solely within
your enterprise provided that all proprietary notices are preserved. You
may not make derivative works of these publications, or reproduce,
distribute or display these publications or any portion thereof outside your
enterprise, without the express consent of IBM.

Rights Except as expressly granted in this permission, no other permissions,
licenses or rights are granted, either express or implied, to the publications
or any information, data, software or other intellectual property contained
therein.

IBM reserves the right to withdraw the permissions granted herein
whenever, in its discretion, the use of the publications is detrimental to its
interest or, as determined by IBM, the above instructions are not being
properly followed.

You may not download, export or re-export this information except in full
compliance with all applicable laws and regulations, including all United
States export laws and regulations.

IBM MAKES NO GUARANTEE ABOUT THE CONTENT OF THESE
PUBLICATIONS. THE PUBLICATIONS ARE PROVIDED "AS-IS" AND
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR
IMPLIED, INCLUDING BUT NOT LIMITED TO IMPLIED WARRANTIES
OF MERCHANTABILITY, NON-INFRINGEMENT, AND FITNESS FOR A
PARTICULAR PURPOSE.

Trademarks

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of
International Business Machines Corp., registered in many jurisdictions worldwide.
Other product and service names might be trademarks of IBM or other companies.
A current list of IBM trademarks is available on the Web at www.ibm.com/legal/
copytrade.shtml.

The following terms are trademarks or registered trademarks of other companies:

Adobe is a registered trademark of Adobe Systems Incorporated in the United
States, and/or other countries.

Intel and Itanium are trademarks or registered trademarks of Intel Corporation or
its subsidiaries in the United States and other countries.
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Linux is a registered trademark of Linus Torvalds in the United States, other
countries, or both.

Microsoft, Windows and Windows NT are trademarks of Microsoft Corporation in
the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Java™ and all Java-based trademarks and logos are trademarks or registered
trademarks of Oracle and/or its affiliates.

The United States Postal Service owns the following trademarks: CASS, CASS
Certified, DPV, LACSLink, ZIP, ZIP + 4, ZIP Code, Post Office, Postal Service, USPS
and United States Postal Service. IBM Corporation is a non-exclusive DPV and
LACSLink licensee of the United States Postal Service.

Other company, product or service names may be trademarks or service marks of
others.
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